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Glossary of Terms 
 

Term Definition 
ADAC As Constructed Asset Data specification used by councils and utilities to 

standardise how asset data is exchanged. Version numbers such as v5.01 
refer to the published schema. 

ADACId The schema identifier stored on each Feature inside the ADAC XML. Not 
the same as the app’s internal Asset ID. 

ADAC XML file The file you load into the app containing Features, their geometry, 
attributes and required metadata defined by the ADAC schema. 

Annotation Text items in the ADAC file drawn on the map as graphics. They behave 
like selectable assets and may have their own styling and rotation. 

Asset A single, mappable record from the ADAC file that you can select on the 
map and inspect in the Asset Details panel. 

Asset ID The internal identifier the app assigns to an asset for selection and 
highlighting. Separate from the ADACId. 

Asset labels On-map text drawn for certain Features when appropriate, such as Lots 
and Easements, showing useful identifiers like Lot number, Plan number or 
area. Visibility depends on settings and zoom level. 

Basemap The underlying map style for context, such as Satellite or Vector. 
Component Information The set of required metadata blocks associated with a Feature, such as 

InfrastructureCode, Owner, Drawing details, dates, Surveyor and Engineer. 
Dimension Measurement graphics from the file, such as linear, aligned, angular, radius 

and arc-length dimensions, displayed with their text and reference lines. 
Duplicate ADACId A condition where the same ADACId appears more than once in a file. 

Explained in a tooltip on the header. 
Element The discipline grouping used across the ADAC XML standard, such as 

OpenSpace, Transport, WaterSupply, StormWater, Sewerage, Cadastre, 
Surface, Enhancements and Supplementary. 

Error highlight A red highlight style for assets flagged for attention, such as duplicate 
ADACIds or assets outside drawing extents. Controlled by the Error toggle. 

Feature An ADAC grouping that collects related Asset types within an Element. 
Often plural, for example “Easements” or “Lots”. Shown alongside the 
Element in the Asset Details header. 

Nil How the app displays a property that has no value in the source file. Nil 
fields are hidden by default in the panel and can be shown on demand. 

Outside drawing extents Status for an asset whose geometry lies beyond the declared extents of the 
drawing or project. Explained in a tooltip on the header. 

Properties All other attributes supplied for the selected Feature that are not part of 
Component Information, such as dimensions, materials, codes or areas. 

Supporting files Linked documents or images referenced by a Feature. Common types 
open in an in-app viewer; others open in a browser tab. 

Tooltip Short on-hover help for labels and warnings in the panel, explaining field 
purposes or issues. 

Zoom visibility The minimum zoom level at which a class of assets or labels will draw. 
Adjustable in Settings. 



1 Introduction 
In modern infrastructure workflows, accurate spatial 
visualisation and validation of asset data are essential for 
effective project delivery and governance. As councils, 
authorities, and utility providers adopt digital standards such as 
ADAC XML, the ability to inspect, verify, and manage asset 
submissions spatially is critical. infrADAC Map provides a web- 
based interface for visualising and interacting with ADAC XML 
data, helping stakeholders validate submissions, analyse 
geometry, and ensure compliance before acceptance into 
operational systems. 

infrADAC Map is a purpose-built web application designed to support councils, government 
agencies, and public utilities in reviewing and validating ADAC XML files. It offers a high- 
performance visual environment where submitted designs can be inspected spatially in real-world 
coordinates, highlighting geometry, metadata, and conformance to schema requirements. The tool 
enables stakeholders to streamline acceptance workflows, conduct visual audits, and explore asset 
data with map-integrated tools. 

1.1 Key Features 
infrADAC Map delivers a robust set of spatial and validation tools for ADAC asset data review. Key 
features include: 

 
• Interactive Map Viewer: Displays ADAC XML files in real-world coordinates using a 

dynamic base map. Assets are rendered with colour-coded symbology, overlaid on satellite 
or vector map views. 

• LGA/Utility Selection: Users can explore metadata for supported councils, utilities, and 
authorities. Map boundaries highlight supported regions, and panels show ADAC versions, 
consortium status, and related utility partnerships. 

• Asset Inspection Tools: Enables users to inspect geometry, attributes, and relationships of 
assets in real time. Assets can be selected individually or in groups for review. 

• Measurement Tools: Built-in tools allow distance, area, and coordinate measurement 
directly within the map environment to validate asset placement and scale. 

• Filter and Layer Management: Users can toggle visibility of assets, classes, background 
layers, and administrative boundaries to suit their review needs. 

• Support Ticket System: Allows users to flag issues or raise general enquiries directly 
through an integrated support modal. 

• No Installation, no payment: infrADAC Map is a fully web-based platform requiring no 
installation. It is accessible from any modern browser and is available 100% free of charge. 

 
With its integrated spatial interface and data-aware tools, infrADAC Map enables asset owners, 
designers, and validators to streamline the review of ADAC XML files in a geographic context, 
improving compliance, accuracy, and operational readiness. 

 



2 Map HUD 
The Map HUD is the on-screen control bar above the map that provides quick access to common 
tasks: navigation, search, basemap switching, finding your location, selecting an LGA/Utility, 
uploading ADAC XML files, and opening the main menu. It stays visible while you work so you can 
pan and zoom without leaving the view. 

 
1. Compass 
Displays the current map orientation; click to 
reset north. 

 
2. Measure Tools 
Opens measurement tools (Length, Area, 
Coordinates). 

 
3. Find My Location 
Centers the map on the user’s current location 
(if supported). 

 
4. Address Search 
Search for an address or location on the map. 

 
5. LGA/Utility Selector 
Select to display Local Government Area or Utility region. 

 
6. Map Zoom In 
Zoom in to the map view. 

 
7. Map Zoom Out 
Zoom out from the map view. 

 
8. Toggle Basemap 
Switch between available basemap styles; Vector and Satellite. 

 
9. Upload 
Upload ADAC XML file/s to the map space. 

 
7. Menu Drop Down 
Opens the main menu for additional tools and settings. 



3 Map Interactions 

3.1 Asset Geometry 
The Asset Geometry feature processes and displays the spatial geometry of 
various infrastructure assets within the map interface. Each asset is classified, 
symbolised, and rendered according to its geometry type, dimensions and any 
associated annotation or measurement details. 

1. Point 
• Used for single location markers. 
• Contains X, Y, Z coordinates. 

 
2. MultiPoint 

• Used for multiple discrete points within a single asset. 
• All points share the same asset classification. 

 
3. Polyline 

• Represents linear features such as pipes, roads, or boundaries. 
• Created from Path definitions. 

 

4. Polygon 
• Represents enclosed areas such as property boundaries, zones, or surface areas. 
• Supports Z-coordinates for elevation data. 

 

3.2 Annotations 
Assets can include annotation graphics for labels or descriptive 
text. 

• Font: Always rendered in Arial. 
• Font size: Scaled proportionally based on height in 

meters. 
• Alignment: Supports left, right, and centre horizontal 

justification. 
• Rotation: Text can be angled to match asset orientation. 
• Optional width: Limits text width for wrapping. 
• Colour: Extracted from asset data, defaults to whit e if 

unspecified. 

3.3 Dimensions 
Some assets include dimensioning information for technical measurements. Supported dimension 
types include: 

• Aligned 
• Linear 
• Angular / Angular3D 
• ArcLength 
• Radius 
• Diameter 
• Ordinate 
• Jogged 



3.4 Curves and Arcs 
The system supports: 

• Circular arcs 
• Elliptical arcs (with rotation, semi-major, and semi-minor axes) 
• All curves are generated as segmented point sets for smooth 

rendering. 
 

3.5 Zoom Visibility 
The Zoom Visibility feature controls when specific assets appear or disappear on the map based on 
the user’s zoom level. This ensures that the map remains clear and uncluttered, while still providing 
access to detailed information when needed. 

 
How It Works 

• Each asset class and geometry type can be assigned a minimum zoom threshold. 
• The system automatically checks the current map scale before rendering a graphic. 
• If the zoom level is outside the asset’s visibility range, that asset is not drawn. 
• Zoom thresholds can be configured per asset type to reflect the user’s preferences. 

 
Default Visibility Rules 

 
Asset Element Approx. Zoom Scale 
Cadastre 1:44,500 
Surface 1:22,200 
Transport 1:11,100 
Supplementary 1:5,600 
WaterSupply 1:2,800 
OpenSpace 1:5,600 
StormWater 1:2,800 
Electrical 1:2,800 
Communication 1:2,800 
Sewerage 1:2,800 
Enhancement 1:2,800 

3.6 Selecting Assets 
The selecting function allows you to focus on a specific feature in the map and review its details 
without visual clutter. 

 
When selected, the asset is highlighted in orange to 
distinguish it from surrounding features. At the same time, 
the Asset Details panel displays all available information 
for that asset, including identifiers, attributes, and any 
related warnings. 

 
Selecting 

• Click directly on the asset within the map view. 
• If the asset is currently hidden due to zoom 

visibility settings, zoom in until it appears before 
attempting selection. 

 
Deselecting 

• Click the same asset again or click in an empty area of the map. 
• The highlight is removed, and the asset returns to its default display. Standard colour for 

normal assets, red for error-marked assets. 



Limitations 
• Only one asset can be selected at a time. Selecting another automatically deselects the 

current one. 
• Selecting an asset with an error temporarily changes its highlight from red to orange; upon 

deselection, it returns back to red. 
 

3.7 Error Highlights 
Assets with detected issues can be highlighted in red to make 
them stand out from normal features. This applies to all asset 
types and geometry, including polygons, lines, points, and 
annotations. Errors may indicate issues such as location 
outside expected boundaries, duplicate identifiers, or failed 
validation rules. When an error-marked asset is selected, its 
highlight changes to orange for clarity, then reverts to red when 
deselected. Error visibility can be toggled on or off to focus 
on problem areas or to declutter the map. 

 

3.8 Asset Labels 
Some asset types, such as lots and easements, contain information that can be displayed directly 
on the map for quick reference. This makes it easier to identify and work with these assets without 
having to select each to open and view their full details. 

 
Labels are controlled from the Filters panel in the Project Details Menu. Toggling the checkbox for 
Asset Labels will display/hide labels for the active file. 

 
When enabled, users can also choose which label information to show for that given asset type. 
Labels appear automatically when you are zoomed in close enough for them to be readable and 
disappear when you zoom out. You can change the label colour using the colour selector in 
Settings. Your label choices are remembered for each file (with cookie tracking enabled) so when 
you reopen it the same labels will be shown or hidden in your specified colour as before. 

 



4 Menu Dropdown 
The Menu provides quick access to key tools, resources and information within infrADAC Map. 
From here, users can explore example datasets, view the map legend, adjust settings, access help 
documentation, review application details, submit support requests, check the update log, and 
explore infrADAC CAD features. Each option is designed to enhance navigation, improve workflow 
efficiency and provide guidance when needed. 

 
1. Examples 
Opens example datasets to demonstrate 
infrADAC Map functionality. 

 
2. Legend 
Displays the map legend, showing symbols 
and colour codes for assets. 

 
3. Settings 
Opens the settings window to configure 
map display and preferences. 

 
4. Help 
Opens the help documentation for 
guidance on using infrADAC Map. 

 
5. About 
Displays application information, version 
number and credits. 

 
6. Support 
Opens support ticket menu for 
troubleshooting, bug reports and general 
assistance. 

 
7. Update Log 
Displays the list of recent updates, changes 
and improvements. 

 
8. Explore infrADAC CAD. 
Links to infrADAC CAD features and capabilities. 

 
5 Examples 
The application includes two built-in ADAC XML example 
projects that can be loaded from the Examples menu. 
These allow you to see how data is displayed for both 
successful and failed validation cases. Forest Groves 
Parkwood is a pass example representing a 50-lot 
residential subdivision. Parkview Place Park is a fail 
example representing an open space park with validation 
issues. Selecting an example will load it into the map so 
you can explore asset labels, error highlights, and other 
features in a realistic context. 



6 Settings 
The Settings Window allows users to customise various aspects of the interface and map behaviour 
to suit their workflow. Users can select a preferred interface theme and default map type that loads 
on startup. The favourites dropdown enables quick access to commonly used LGAs or utilities by 
pre-selecting them in the feature selector. Asset categories can be individually styled by choosing 
default colours and setting the zoom level at which each asset becomes visible. Label settings 
include a default label colour and attribute visibility options for lot and easement assets. All changes 
can be applied to the current session without saving or permanently saved for future sessions if 
cookie tracking is enabled. Users can also reset all values to default or close the window without 
applying changes. 

 
1. Theme 
Select the interface theme (System Default, Light, 
Dark). 

 
2. Default Map 
Set the default map type on startup (Vector, 
Satellite). 

 
3. Favourites 
Choose the default favourite LGA/Utilities for quick 
access. 

 
4. Default Colours (Asset Elements) 
Define the default colour for each asset type. 

 
5. Zoom Visibility (Asset Elements) 
Set the zoom level at which specified asset 
categories becomes visible. 

 
6. Default Colour (Labels) 
Set the default colour for specific asset categories. 

 
7. Lot Properties 
Select the visible property attributes to display for 
lot assets. 

 
8. Easement Properties 
Select the visible property attributes to display for 
easement assets. 

 
9. Apply 
Apply changes to the current session without 
closing the window. 

 
10. Save 
Save settings as defaults for current and future sessions. 

 
11. Reset 
Restore all settings to default values. 

 
12. Close 
Close the window without saving changes. 



7 Support Ticket 
The Support Ticket modal allows users to submit issues, requests, or enquiries directly to the 
support team. The form includes mandatory fields for name, email, subject, and description, each of 
which is validated before submission. Priority level and support type help categorise the ticket for 
proper handling. An optional log attachment can be included to assist with diagnostics by capturing 
internal application activity. 

 
1. Priority Level 
Select the urgency of the support request (Low, 
Medium, High). 
2. Contact Name 
Enter a contact name for the support ticket. 
3. Support Type 
Select the type of support request (e.g., General 
Enquiry, Bug Report, Feature Request). 
4. Contact Email 
Enter the email address for support 
correspondence. 
5. Subject 
Enter a brief title describing the issue or request. 
6. Description 
Provide a detailed description of the issue or 
request. 
7. Attach Log 
Option to attach application logs for 
troubleshooting. 
8. Submit 
Send the completed support ticket to the support 
team. 
9. Cancel 
Cancel the ticket submission and close the 
window. 

 
 
8 Update Log 
The Update Log lists release notes for each 
version and highlights the most recent entry with 
“(latest).” Use the list on the left to pick a version. 
The details panel on the right shows the release 
title, date, version number, a short summary, and 
the changes grouped under New, Improved, and 
Fixed. Click an item to view its notes. Close the 
window with Close or by clicking outside the 
panel. 

 
Notes are ordered with the newest at the top. The 
log currently uses built-in data and will display the 
latest updates and fixes from the server when 
available. 



9 Map Legend 
The Map Legend provides visual references for interpreting both regional 
boundaries and asset geometry on the map interface. Administrative 
regions are displayed as coloured boundary overlays, distinguishing 
jurisdictions and Authority Controlled areas. Asset types are represented 
using standardised map symbols for different geometries, allowing users 
to quickly identify points, segments, polylines, and polygons. The legend 
is toggled via the main menu and can be repositioned freely by the user. 

 
1. Administrative Regions 
Displays boundary overlays for regional administrative areas (e.g., 
Queensland LGAs, NSW LGAs, NT Region, Authority Controlled). 

 
2. Asset Types 
Shows the map symbols used for different asset geometry (Point, 
Segment, Polyline, Polygon). 

 
10 LGA/Utility/Authority Selector 
The LGA, Utility, and Authority Selector provides detailed information 
panels based on the selected organisation type. Each panel also 
corresponds to live map data, with the selected LGA or utility’s supported 
regions and boundaries visually highlighted on the map for spatial 
reference. 

 
LGAs (Councils) 

 

When an LGA is selected, the panel displays: 
• Council Name: The geographic area or administrative zone the council is part of (e.g. 

Brisbane City, Gold Coast City). 
• ADAC Consortium Member: Indicates whether the 

council is a certified member of the ADAC Consortium: 
• Website: Link to the official council website. 
• Supported ADAC Standard: The version of ADAC the 

council supports. 
• ADAC Supported Utilities: Lists utility organisations 

working with the council, each with its icon. Legacy 
utilities such as Allconnex Water are marked with a 
warning indicator and labelled accordingly. 

 
 



Utilities 
 
When a Utility is selected, the panel displays: 

• ADAC Consortium Member: Status indicator for 
membership. 

• Website: A link labelled Utility Website pointing to the 
organisation’s homepage. 

• Supported ADAC Standard: The utility’s implemented 
ADAC version. 

• Utility Type: Lists supported infrastructure types. 
• Supported LGAs: Displays all councils serviced by 

the utility. Each entry includes: 
o Council name 
o Council icon 
o ADAC support status 

• ADAC Supported Utilities: (if applicable) Lists 
additional utilities that may collaborate with the 
selected utility. 

 
Authorities (e.g. Port of Brisbane) 

 
Authorities are technically handled as utilities with a special 
case override. The panel displays: 

• ADAC Consortium Member: Status indicator for 
membership. 

• Website: Labelled Authority Website. 
• Supported ADAC Standard: Version supported. 
• Supported LGAs: Lists LGAs that interact with or fall 

under the authority’s service scope. 
• ADAC Supported Utilities: Shown similarly to council 

panels, listing utility organisations the authority works 
with (e.g. Urban Utilities for Port of Brisbane). 



11 Project Details Menu 
1. Loaded ADAC XML File (Current) 
Indicates the currently active ADAC XML file being 
viewed. 

 
2. Loaded ADAC XML File/s 
Indicates other loaded ADAC XML files (not currently 
selected). Up to five XML files can be loaded at a time. 

 
3. Project 
Displays general project level information from the 
currently selected ADAC XML file. 

 
4. File Details 
Displays ADAC XML file metadata including information 
such as owner, receiver, drawing numbers and dates. 

 
5. Coordinate System 
Displays the coordinate reference system information 
as defined in the currently selected ADAC XML file. 

 
6. Drawing Extents 
Contains information about the ADAC XML file’s 
drawing extents. 

 
7. Surveyor 
Displays the surveyor details of the ADAC XML file. 

 
8. Engineer 
Displays the engineer details of the ADAC XML file. 

 
9. Software 
Displays the software information recorded at the 
creation of the ADAC XML file. 

 
10. Asset Details 
Displays general asset information from the currently 
loaded ADAC XML file. 

 
11. Filter 
Enables filtering of displayed ADAC XML asset data. 

 
12. ADAC XML Supporting Files 
Upload supporting files linked to the current ADAC XML 
file. 

 
13. ADAC XML File Name 
Displays the name of the loaded ADAC XML file. 

 
14. ADAC XML File Version 
Displays the ADAC XML standard version of the file. 

 
15. Footer Information 
Displays the current application’s version information. 

 
16. Menu Hide/Show 
Toggles the visibility of the Project Details Menu. 



11.1 Project Tab 
The Project tab displays two key properties from the loaded 
ADAC XML file: 

• Project Name – The name of the project as defined 
in the XML file. 

• Export DateTime – The date and time the file was 
exported from the software that created it. 

 
The Export DateTime value is subject to ISO 8601 formatting 
requirements. Many software packages incorrectly format 
this value, assuming that their default output meets ISO 
8601. infrADAC Map enforces full compliance and any 
deviation from the standard will result in an audit error. 

11.2 File Details Tab 
The File Details tab displays key project information taken 
directly from the loaded ADAC XML file. The properties 
include: 

• Owner – The owner of the project. 
• Receiver – The council, utility, or organisation 

receiving the ADAC data. 
• Works Approval ID – The relevant works approval 

identifier. 
• Drawing Number – The project drawing number. 
• Drawing Revision – The drawing revision identifier. 
• Construction Date – The project’s construction 

completion date. 
• Project Status – The project status (e.g. As 

Constructed). 
• Description – A short description of the project. 

 

The Receiver property is audited in connection with the Drawing Extent coordinates. Both must 
align so that the receiver’s name matches one of the approved receiver names for the Local 
Government Area (LGA) determined from the extents. 

 
• Valid Receiver in Correct Area 

If the receiver name matches an approved name for the LGA based on the extents, it is 
accepted. Valid receivers are displayed with an icon that links to their official website. 

• Valid Receiver Name in Incorrect Area 
If the receiver name is correct but the drawing 
extents place the project outside that receiver’s 
approved area, it is highlighted as an issue. 

• Invalid Receiver Name 
If the receiver name does not match any approved 
receivers, it is rejected outright and flagged as an 
error. 

• Legacy Receivers 
Some receivers, such as Allconnex Water, are recognised as legacy receivers. These are 
supported for backward compatibility, but when the icon is 
hovered, the user is notified that the receiver is legacy. 



11.3 Coordinate System Tab 
The Coordinate System tab displays information about the coordinate reference system defined in 
the ADAC XML file and validates it against the expected ADAC standard. 

 
The tab lists the Horizontal Coordinate System, Horizontal Datum, 
Vertical Datum, and related properties. This information is taken 
directly from the XML file. Hovering the  icon next to the 
Horizontal Coordinate System property will show the project 
extents on the MGA zone map. This visual assist’s the user in 
confirming that the drawing extents align with the specified MGA 
zone. 

 
The Horizontal Datum value is compared directly with the 
expected standard for the loaded ADAC XML file version: 

 
• ADAC XML v5.0.1 and later 

The expected Horizontal Datum is GDA2020. If 
the file specifies any other datum, such as 
GDA94, the tab will display an error. This 
ensures that projects submitted under current 
ADAC versions use the correct coordinate 
system. 

 
• ADAC XML versions prior to v5.0.1 

The Horizontal Datum check is not enforced. 
These earlier standards may legitimately use 
datums such as GDA94 without triggering an error. 

 
If the MGA zone defined in the Horizontal Coordinate System 
is valid, the extents are further checked to ensure they fall 
within acceptable MGA bounds (easting range). Any extents 
outside the expected range for the specified zone will 
generate a warning. 

 
The Coordinate System tab updates automatically with the 
currently selected ADAC XML file. Selecting a different file 
will refresh the displayed values and recheck against the 
appropriate version requirements. 



11.4 Drawing Extents Tab 
The Drawing Extents tab displays the coordinate bounds of the loaded ADAC XML file and verifies 
whether the extents fall within an approved Local Government Area (LGA). The extents are defined 
by their SouthWest (X, Y) and NorthEast (X, Y) coordinates. 

The system performs an automatic validation against approved LGAs when the file is loaded. The 
validation results are displayed in the Drawing Extents tab using status icons and messages: 

• Approved within a single LGA 
When the drawing extents fall entirely within a 
recognised and approved LGA boundary, the tab 
displays a green status indicator. The name of the 
approved LGA is shown beneath the extent 
coordinates. In this case, no corrective action is 
required. 

• Extents not within any approved LGA 
If the drawing extents do not intersect with any 
approved LGA boundaries, the tab displays a red 
status indicator. The map panel will show the extents 
outlined, and the system will advise that the extents 
are outside all approved LGAs. The user should review 
and correct the coordinate data to ensure the project is 
located within an approved LGA. 

• Extents cover multiple LGAs 
When the drawing extents overlap more than one LGA, 
the tab displays an amber status indicator. The system 
lists both the approved and denied LGAs and 
recommends that drawing extents be adjusted to fall 
entirely within a single approved LGA. This ensures 
clarity in jurisdiction and compliance with ADAC 
submission requirements. 

The Drawing Extents tab updates dynamically with the 
currently selected ADAC XML file. Adjusting extents or 
selecting a different file will refresh the validation results 
accordingly. 

11.5 Surveyor Tab 
The Surveyor tab displays the surveyor responsible for 
the project as recorded in the ADAC XML file. It includes 
the surveyor’s name, the date the final survey was 
completed, and the date the survey was approved. 

 
The information is provided for reference only and is not 
subject to any audit or validation by infrADAC Map. The 
tab updates automatically to show the details relevant to 
the currently selected ADAC XML file. 



11.6 Engineer Tab 
The Engineer tab displays the engineer responsible for 
the project as recorded in the ADAC XML file. It includes 
the engineer’s name and the date the work was 
approved. 

 

Like the Surveyor tab, this information is for reference only and is not audited. The tab updates 
automatically when switching between loaded ADAC XML files to display the details for the currently 
selected file. 

11.7 Software Tab 
The Software tab displays the software application used 
to create the loaded ADAC XML file, along with its 
version number. This information is extracted directly 
from the file metadata. 

There is no audit process associated with the Software 
tab. Its primary purpose is to provide reference 
information to identify the originating software. Recognised software packages are displayed with 
their respective application icon and include a direct link to the developer’s website. 

If the software is not recognised, no icon or link will be shown, but the software name and version 
(as recorded in the ADAC XML file) will still be displayed. Developers who wish for their software to 
be recognised by infrADAC Map can apply through the support ticket system. 

11.8 Asset Details Tab 
The Asset Details tab provides a summary of the total number of assets recorded in the currently 
selected ADAC XML file, grouped by asset type. 

 
The three categories displayed are: 

• Standard Assets – The total number of standard 
assets defined in the file. 

• Supplementary Assets – The total number of 
supplementary assets defined in the file. 

• Enhancement Assets – The total number of 
enhancement assets defined in the file. 



11.9 Filter Tab 
The Filter tab provides full control over the visibility and 
display colours of asset classes and individual assets within 
the drawing space for the currently selected ADAC XML file. 
It is also where users can expand asset classes to inspect 
each asset by name and ADACId. 

 
Asset classes that are not used in the currently selected 
ADAC XML file will appear greyed out. These cannot be 
expanded or toggled because there is no corresponding data 
in the active file. 

 

For asset classes that are present: 
• Colour Swatch: The coloured square beside each 

asset class sets the display colour for that class in 
the drawing space. Clicking the swatch opens the colour picker. Changing the colour affects 
all loaded ADAC XML files that contain that class. 

• Class Visibility: The checkbox beside the asset class name controls whether all assets in 
that class are visible or hidden in the drawing space. 

• Expanding a Class: Selecting the + icon to the right of the class name expands the class to 
show all individual assets in that class. Each is listed with its asset name and ADACId. 

• Individual Asset Visibility: Each individual asset in the expanded list has its own checkbox 
that allows the user to toggle its visibility separately from the rest of the class. 

 
Assets that have issues identified during auditing will be 
highlighted in the expanded asset list. Hovering the cursor over 
an asset with an issue will display a tooltip containing the specific 
error message. When an asset is selected directly in the drawing 
space, it will also be highlighted in green within the Filter tab for 
easy identification. 

 
Changes made in the Filter tab are applied in real time to the 
drawing space. The Filter tab always reflects the currently 
selected ADAC XML file, and selecting another file will update the 
tab to display that file’s available asset classes and assets. 



12 Asset Details Menu 
1. Header 
Shows the asset name and ID, plus the Feature and Element. 

 
2. Properties 
Lists recorded attributes for the selected asset. 

 
3. Component Information 
Shows standard project and compliance fields such as 
Infrastructure Code, Owner, drawing and approval details, 
Status, and Data Quality. 

 
4. Supporting Files 
Lists files linked to the asset when available. 

 

5. Menu Hide/Show 
Toggles the visibility of the Project Details Menu. 

12.1 Properties Tab 
The Properties tab displays all recorded attributes for the selected 
asset, showing each property name alongside its value. Properties 
with no recorded value are marked as (Nil) and are hidden by 
default to keep the view uncluttered. These can be revealed by 
selecting the  eye icon in the section header, and the panel will 
automatically resize to fit the additional fields. 

Tooltips are available for many labels, providing a short 
description of a field’s purpose or expected content when you 
pause the pointer over them. Section headers may be highlighted 
to indicate warnings or data issues. Hovering over a highlighted 
header will explain the cause, such as duplicate IDs or locations 
outside the drawing extents. 

12.2 Component Information Tab 
The Component Information section provides a breakdown of all 
components linked to the selected asset. Each component is listed 
with its relevant details. Nil fields are hidden by default here as well 
and can be shown or hidden by selecting the  eye icon in the 
section header. The toggle helps control how much information is 
displayed on screen. 

Like the Properties section, component labels may also include 
hover help tooltips. These clarify the meaning of specific fields or 
explain the role of a component within the asset. This is particularly 
useful for more specialised or uncommon components where the 
field names alone may not be self-explanatory. 

12.3 Supporting Files Tab 
The Supporting Files section provides a breakdown of all external 
documents linked to the selected asset. For details regarding 
Supporting files please see Section 15. 



13 Auditing 
infrADAC Map is equipped with a basic auditing tool that evaluates the currently loaded ADAC XML 
file and highlights issues in relation to the current ADAC XML standards. IPWEAQ’s ADAC XML 
data dictionary is used to verify specific assets, property types, and general project details. 

The auditing tool analyses six specific components of the ADAC XML file: 
• Project detail property types (strings, integers, floats, bools, etc.) 
• Drawing extent coordinates and their correlation to the specified Receiver and Region, 
• Required fields at the project level 
• Asset positioning within drawing extents 
• ADACId duplication 
• Asset geometry type 

 
Note: Only infrADAC CAD has the ability to audit specific asset properties in detail and generate a full 
audit report. infrADAC Map’s audit should be used as a general guide only, as issues may still be present 
with specific asset properties. 

 
Each file is automatically audited when loaded into infrADAC Map. The user is initially notified of all 
detected issues via an on-screen popup notification, as shown below. 

 

To view each issue identified in the ADAC XML file, the Project Details Menu automatically 
highlights each affected project detail tab with a flashing  caution icon. Hovering over this icon 
displays a tooltip with details of the issue in the tab dropdown. Opening an affected tab will highlight 
the specific property with a similar tooltip message. 

The Filter tab lists all issues identified with individual assets. Assets whose geometry lies partly or 
entirely outside the drawing extents area are flagged as issues. All asset ADACId values are also 
checked to ensure uniqueness across the ADAC XML file. Assets with names, categories, or 
property details that do not match IPWEAQ’s data dictionary will not be highlighted as issues. It is 
the responsibility of the designer to ensure these details are correct. Assets with issues can be 
highlighted in red within the drawing space by clicking the  eye icon in the Filter tab. For full audit 
capability of ADAC XML files, including detailed reporting, please use infrADAC CAD. 

When multiple files are loaded, auditing errors are only visible for the currently selected ADAC XML 
file. Clicking another file’s tab will display that file’s specific errors and issues, if any. 

https://www.infradac.au/CAD


14 Measurement Tools: 
The Measure Tools provide precise measurement functionalities directly within your application 
interface. Accessible via a convenient toolbar button, the Measure Tools include three primary 
features: 

 
1. Distance Measurement 
Measures the distance between selected points on the map. 

 
2. Area Measurement 
Calculates the area within a defined boundary on the map. 

 
3. Display Coordinates 
Displays the geographic coordinates of a selected point 
(Easting, Northing in MGA). 

14.1 Measure Distance 
• Click the Measure Tools button on the toolbar and select 

"Measure Distance" from the dropdown. 
• If you have an asset already selected, their total distance 

per segment will be automatically measured and 
displayed. 

• If no assets are selected, click sequentially on the map 
or interface to define measurement points. 

• The total distance between the selected points is 
dynamically displayed as points are added. 

• Click the Measure Tools button again to reset and exit measurement mode. 

14.2 Measure Area 
• Activate the Measure Tools button and select "Measure 

Area" from the dropdown. 
• If an asset is already selected, the area and perimeter of 

the asset will be automatically calculated and displayed. 
• If no asset is selected, click on the map to define the 

vertices of the area you wish to measure. 
• Complete the measurement by double-clicking the last 

vertex point. 
• The enclosed area and perimeter is displayed and 

updated as additional vertices are added. 
• Exit measurement mode by clicking the Measure Tools 

button again. 

14.3 Display Coordinates 
• Select "Display Coordinates" from the Measure Tools 

dropdown menu. 
• If an asset is already selected, its coordinates are 

immediately displayed. 
• If no asset is selected, click on the desired location on 

the interface. 
• The coordinates of the selected point are instantly 

shown. 
• To measure coordinates of another point, simply click 

another location. 
• Exit coordinate display mode by clicking the Measure Tools button again. 



15 Supporting Files: 
The Supporting Files feature allows you to attach external documents, 
images, and other file types to individual assets in your uploaded XML 
dataset. These files are packaged in a single ZIP archive and linked to 
assets by matching folder names in the ZIP to the AssetType and 
ADACId values from the XML file. This feature helps consolidate all 
asset-related records into one location for easy reference. 

 

Supporting files may include: 
• PDF inspection reports 
• Photos 
• CAD drawings 
• Spreadsheets 
• Manufacturer manuals 
• Any other relevant documentation 

15.1 Uploading Supporting Files 
1. Upload an XML File First 

Supporting files are only accepted after an XML file 
has been uploaded and selected. 
If no XML file is active, an error will be displayed. 

2. Access the Upload Section 
o After uploading an XML file, the Supporting 

Files upload section becomes visible. 
o You can drag and drop your ZIP into this area 

or click to browse for it. 
3. Accepted Format 

The ZIP must follow the exact folder structure rules described below. The system audits 
the contents during upload. 

4. Audit Feedback 
o The application will display the number of 

assets with linked supporting files. 
o If structure issues are detected (empty folders, 

incorrect names, nested subfolders, or 
unmatched folders), the count will be 
highlighted, and a tooltip will display the list of 
issues. 

15.2 ZIP Folder Structure Requirements 
To be recognised and linked, your ZIP archive must meet the following requirements: 

 
Rule Requirement 
Top-level folders 
only 

Only folders in the ZIP root are considered. 

Folder naming 
pattern 

AssetType (ADACId). Must match the asset type and ADACId exactly as 
they appear in the XML. Case-sensitive. 

No subfolders Files must be directly inside the asset folder. Subfolders trigger a structure 
warning. 

Not empty Each asset folder must contain at least one file. Empty folders trigger an 
empty-folder warning. 

Matching rule If no asset in the XML matches the folder name, it is flagged as no match. 
File types Any file extension is accepted. No content validation is performed. 



15.3 XML Format Structure Requirements 
For supporting files to be linked correctly, the uploaded XML file must meet the following 
requirements: 

 
1. SupportingFiles Element Location 

o The <SupportingFiles> element must be placed inside the <ComponentInfo> element 
for the asset it belongs to. 
Note: namespace prefix has been excluded from element names for clarity. 

2. Content Format 
o The <SupportingFiles> element must contain a comma-separated list of bare file 

names (with extensions). 
o File names must match the files placed in the corresponding ZIP folder for that asset. 
o Do not include file paths, media types, or any other metadata. 

3. File Name Match 
o Each file name listed in <SupportingFiles> must exactly match (case-sensitive) a file 

name inside the correct ZIP folder for that asset. 
4. No Extra XML Tags 

o Do not wrap individual file names in <File> or any other sub-elements. 
o Only plain, comma-separated text is supported. 



<SupportingFiles> 
SitePhoto_250812.pdf, AsCon_RevB.dwg, AuditReport_250812.pdf 

</SupportingFiles> 

Appendix A 

Example XML and Zip Folder Structure (Supporting Files) 
XML Structure: 

 

 
Zip File Structure: 

SupportingFiles.zip 
└── Lot (40266745) 

├── AsCon_RevB.dwg 
├── AuditReport_250812.pdf 
└── SitePhoto_250812.png 

 
 
FOLDER_NAME.zip 
└── ASSET_TYPE (ADACID) 

├── FILE_A.EXT 
├── FILE_B.EXT 
└── FILE_C.EXT 
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